Canon

1850

Color Bubble Jet Printer

Quick Start Guide



Canon i850 Color Bubble Jet Printer Quick Start Guide.

Copyright
This manual is copyrighted by Canon U.S.A., Inc. with all rights reserved. Under the copyright laws,

this manual may not be reproduced in any form, in whole or in part, without the prior written
consent of Canon U.S.A., Inc.

© 2002 Canon U.S.A,, Inc.

Disclaimer

Canon U.S.A., Inc. has reviewed this manual thoroughly in order that it will be an easy-to-use
guide to your Canon i850 Color Bubble Jet Printer. All statements, technical information and
recommendations in this manual and in any guides or related documents are believed reliable, but
the accuracy and completeness thereof are not guaranteed or warranted, and they are not intended
to be, nor should they be understood to be, representation or warranties concerning the products
described.

Specifications are subject to change without notice.

/\ As an ENERGY STAR partner, Canon U.S.A., Inc., has determined that this product meets
gl the ENERGY STAR guidelines for energy efficiency.

All information regarding non-Canon products was compiled from publicly available information. No
representation is made regarding the accuracy thereof.

Trademarks

Canon is a registered trademark of Canon Inc. PhotoRecord is a trademark of Canon Information
System Research Australia. Macintosh, Mac and the Mac logo are registered trademarks of Apple
Computer, Inc., registered in the U.S. and other countries. All other product and brand names are
trademarks of their respective owners.

Canon U.S.A., Inc.
One Canon Plaza
Lake Success, NY 11042



Contents

Contents
Basic Printing
Turning the Printer’s POWer On ... ..ttt ittt ittt inereereernesoesnesnssnasnannns 2
Loading Paper vttt ittt it e et et e e e 3
Using SpecialMedia . ...oovuiiiiini ittt ittt iiieetineetenesennssonnesonnesnnns 5
Printing With Windows . ... .ottt i i it ittt teeteeeneeannneenannans 7
Printing with Macintosh . ... .ottt i it ittt ieeteanneennsnnnnannnns 9

Advanced Printing

Applications Included inthe CD-ROM Package .......c.cvviuiiiiennreenerenneeennnnnnnnns 11
Printing photographs with Windows . .. ...ooiiiii it ittt innnnnnns 12
Printing photographs with Macintosh. ........ ... oot i it it iineenns 15
ACCeSSING Printer DriVer .. ottt ittt iieeteeeereeennseosooasnssosssasnnannns 19
Adjusting Print Quality for Photographs . ........ciiiiiiiiii ittt iiiiiineeennnnn 21
Using Printer Driver Options. . .. ovi ittt ittt ittt ieetneeeaeneenesoaonasnannns 28

Printing Maintenance

Replacingan Ink Tank. ... ...ttt ittt iieeeeeerennneeanasonnanans 29
When Printing Becomes Faint or Colors arelIncorrect ........c.ciiiiiiiiiiiinninnnnnnnnn. 34
Printing the Nozzle Check Pattern...... ..ottt ittt 35
Print Head Cleaning. ... vut ittt ittt iiie e iteeeeeneeenneeeoneeonnaeonnneannnenns 37
Print Head Deep Cleaning. .. ovv v it tinttiitiieeeeinereeneeeeneoenneasnnesennensnns 40
Aligning Print Head . ....viitir ittt ittt ittt tnneeeaneeonneeennaeonnnennnnns 42
Troubleshooting
Cannot Install the Printer Driver. . ... iti ittt it i ittt ittt eneenaenaanaannns 47
Print Quality is Poor or ContainS Errors. . ...ovuitiiiiiiiiitiinnriinerennseennssennnsens 48
Troubleshooting Printer Hardware. . . ... ..ottt i i it it ittt ineenaennnns 50
Paper Does Not Feed Properly .....covitniiiiniiiiii ittt iiiitiinneintecnneneennsens 51
Handling Error MESSages ..o v v ittt it ittt iieiteineneeneenesneenesnesneonesnannns 52
An Error Message Appears onthe Screen.......c.ooviiiii it iiiniinnrinneeenneeennnns 53
Appendix
User's Guide Table of Contents ... ..ottt ittt teeneennenaenannns 54
LYo LYoot T o 1 = 55
Safety Precautions .. ..viuii ittt ittt i it i e e e e 57
Regulatory Information. ......cooiiitiiiiiiiiiiit ittt ettrennnaeaesoannnnns 59
CANON LIMITED WARRANTY - (USAONLY). ..ottt et e eeenaannns 60
1T (=D G 62



Basic Printing

Basic Printing

Note This Quick Start Guide describes some of the features of your
i850 printer and how to use them. For more information, view
the i850 User's Guide on the Setup Software & User's Guide
CD-ROM, or use the online help in your printer interface:

(Windows|

While in the printer's Properties window press the F1 key, or
click? in the upper right corner then click the feature you want
to know more about, or click the Help button when displayed.

Turn Balloon Help on by selecting Help, then Show Balloon
Help.

Turning the Printer’s Power On

1 Turnonthe printer by pressing the POWER button.

The POWER lamp flashes while the printer warms up and changes to steady (non-
flashing) green when the printer is ready.

Note |fthe POWER lamp changes to orange and begins flashing,
refer to the section "Handling Error Messages" on page 52.
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Loading Paper

B Print Media to Avoid

Do not use the following types of paper. Using such paper will not only produce
unsatisfactory results, but can also cause the printer to jam or malfunction.

1

Folded, curled or wrinkled paper

Damp paper

Excessively thin paper (less than 64 gsm or 17 |b)
Excessively thick paper* (more than 105 gsm or 28 lb)
*non-Canon branded paper

Picture postcards

Postcards affixed with photos or stickers
Envelopes with double flaps

Sealed envelopes

Envelopes with an embossed or treated surface
Any type of paper with holes (such as loose-leaf)

Loading the Print Media

In this example, description is provided of the steps used to load Plain Paper in your
printer.

For detailed information on the specialty media Canon provides for use with its
various printers, refer to the section "Using Special Media" on page 5.

Consult the User’s Guidefor detailed instructions on how to load envelopes and
specialty media in the printer.

Flatten the four corners of the paper before loading it.

Important When paper is curled, hold the opposing curled corners and
gently bend them in the opposite direction until the paper
becomes completely flat.



Basic Printing

2 Preparing to Load Paper

(1) Open and pull out the
paper rest.

(2) Open the cover and pull out
the paper output tray.

(3) Open the front cover and adjust the paper thickness lever to the correct position
for the media in use.
Move to the left position for plain paper.
Move to the right position for envelopes, Banner Paper and T-Shirt Transfers.
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3

Loading the Paper

Limit Mark
Do not load beyond this Load Limit Mark.

(1) Insert the paper in the
sheet feeder with print
side facing up.

(2) Align the paper stack snug
against the right side of
the sheet feeder.

(3) Press the paper guide and slide it against
the left side of the stack of paper.

Note @ Do not stack more than 50 sheets in the paper output tray.
® Do not touch the printed surfaces until the ink dries. For
specific drying times, refer to the instructions packaged
with your media.

Using Special Media

Canon recommends that you use genuine Canon media to insure optimal print quality.

B Photo quality media B Media suited to business
* Photo Paper Pro documents
* Photo Paper Plus Glossy e High Resolution Paper
e Matte Photo Paper ° Transparencies
¢ Glossy Photo Paper
* Glossy Photo Cards
e High Gloss Photo Film
[ J

High Resolution Paper
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B Canon Special Media

Media Type

Paper Rest Load
Limit

Paper Thickness
Lever Position

Printer driver setting

Media Type

Bubble Jet Paper Up to 150 sheets Left Plain Paper
Brilliant White Paper |Up to 150 sheets Left
Banner Paper 1 sheet(can print up |Right

to 6 connected

sheets)
Photo Paper Pro Letter: Up to 10 Left Photo Paper Pro*1*2

sheets

4” x6”: Upto 20

sheets
Photo Paper Plus Letter: Up to 10 Left Photo Paper Plus
Glossy sheets Glossy

4” x 6”:Up to 20

sheets
Matte Photo Paper Up to 10 sheets Left Matte Photo Paper
Glossy Photo Paper |Upto 10 sheets Left Glossy Photo Paper
High Resolution Up to 80 sheets Left High Resolution
Paper Paper
High Gloss Photo 1 sheet Left High Gloss Photo
Film Film
Glossy Photo Cards | Up to 20 sheets Left Glossy Photo Paper

*2

T-Shirt Transfers 1 sheet Right T-Shirt Transfer
Transparencies Up to 30 sheets Left Transparency

Note @ Fordetailed description of print media types, refer to the

User’s Guide.

® *1:When loading Letter size paper on the auto sheet
feeder, do not load the paper at once. To avoid sticking,
load the necessary number of paper (up to 10 sheets) one
at a time.

® *2: Print settings are much easier to select if you use the
applications included on the Setfup Software & User’s Guide
CD-ROMwhen printing with Photo Paper Pro (4” x 6”) and
Glossy Photo Cards.
For instructions on how to print from the software
applications, refer to the Photo Application Guide.
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(Windows
Printing wit

Note

h Windows

Note that the names of features and functions listed in Print

menus and dialog boxes may vary, depending on the
software application you are using. The steps described in
this section are for printing in Windows XP.

1 create a document or open a file to print.

2 Open Printer Properties dialog box.

(1) Select Print from the application software's File menu.

General |

Select Printsr

= &

Add Prinker

Location:

Page Rangs
(oL}
Selection

Pages:

Status: Ready

[ Pt o i
MNumber of copies: ‘
Current Page
CHCEIL

o

Note

(2) Ensure that Canon i850
is selected.

(3) Click Preferences
(or Properties).

In Windows 2000, click the Main tab in the Print dialog box.
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3 Specify the required settings.

T T (1) Click Media Type to select
mn O the type of media loaded in
D the printer.

© Custom St
Color Adjustment: ® Auto

O Manual Set
[ Grayscale Printing
[] Preview before printing

(C= === () Click OK.

Note @ Fromthe Page Setup tab selectthe correct document size to

be printed.

® To adjust Print Quality settings, select Custom and click Set.
You can control quality in the Set Print Quality dialog box.

® For detail about other printer driver functions, refer to the
User’s Guide or Help.

® Select Preview before printing by clicking the check box.
This displays a preview screen that allows you to confirm
the selected printing effects and how your document will
look when printed. Some applications do not contain the
function to display the preview.

4 Print the Document

General ‘

Select Printer

Stas: Ready D Fiint o fle
Lot

Pags Range

®@al MHumber of copies: E

Selection () Current Page

Pages |:| Callate m
Calel ol
| (1) Click Print or OK.
() =

Note Youcan cancela printjob in progress by simply pressing the
RESUME/CANCEL © button.
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Printing with Macintosh

Note

The menu screens and dialog boxes that appear may vary,
depending on the software application you are using.

The steps described in this section are for printing Mac OS 9.

1

2 Select Paper Size

Create a document or open a file to print.

(1) Selectthe Page Setup from the application software's File menu.

‘Canon ig850

Versi

on4.1

Height:11.00in Width :8.50in

J

Paper Siz¢; [ Letter

B —

[ Banner Printing
[ Borderless Printing
Amount of Extension :

Min. g M

Cancel

lax.

scale:  [100 2] %

[ Save Settings

(3) Click OK.

Specify the required settings.

(2) Select the desired paper
size from the Paper Size
pull-down menu.

(1) Select Print from the application software's File menu.

Version 4.1

Letter
Normal-size printing

Canon ig50

)
o El __Cancel
Pages: @ All -

ofom [ 1 [ ]

BI Cartridge :
[Cnlnr ﬂ
Media Type : \
Plain Paper i.l

Auto Feeder

(2) Select the Media Type from
the pull-down menu.

Print Mode :
Text

Details...

[ Grayscale Printing

(4) Click Print.

(3) Select a type of document
from the Print Mode pull-
down menu.
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Note ® When you select a type of document from the Print Mode
pull-down menu, the document will be printed in colors and
Print Quality suited to the characteristics of the Media Type
you have selected.

Text:

Graphic:

Photo:

Manual:

Select when printing documents consisting
mainly of text.

Select when printing documents consisting
mainly of graphs and graphics (illustrations)
with strong color definition.

Select when printing documents consisting
mainly of photographs and graphics featuring
fine color gradation.

If you select Manual, the Details button will
become selectable. Click Details button to
display the Detailed Setting dialog box where
you can fine-tune the Print Quality and
Halftoning settings.

Refer to the User’s Guide.

For detail about the printer driver functions, refer to the
User’s Guide or Help.

® You can cancel a print job in progress by simply pressing
the RESUME/CANCEL & button.
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Advanced Printing
Applications Included in the CD-ROM Package

The Setup Software & User’s Guide CD-ROMincludes photo applications
designed to edit the photographs taken by digital camera and print them as
photo-lab quality prints without standard white borders. Please use the
application(s) suitable for your print purposes.

Note @ Applications are easy to install. Just go to £asy Setup
Instructions and follow the instructions.
® For detailed description of the various features of photo
applications and instructions on their use, refer to the
Photo Application Guideinclude on the Setup Software &
User’s Guide CD-ROM.

W Easy-PhotoPrint (Windows)

You can make a Borderless Printing easily and quickly, just by selecting a photograph
taken with a digital camera and the paper type on which to print. You can also use
simple editing features such as trimming and image rotation.

It is Exif Print (Exif 2.2) compatible.

B ImageBrowser (Macintosh)

You can import photographs taken with a digital camera into the computer, edit and
caption them.

You can also make a Borderless Printing or Index Print without difficulty.

It is Exif Print (Exif 2.2) compatible.

B ZoomBrowser EX/PhotoRecord (Windows)

You can import photographs taken with a digital camera into the computer, edit and
caption them, and print them in an album.
PhotoRecord is Exif Print (Exif 2.2) compatible.

B PhotoStitch (Windows/Macintosh)

You can merge a selected sequence of photographs to create a panoramic photo.

11
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(Windows|
Printing photographs with Windows

This chapter describes only the steps used to print from photo applications included with
your Setup Software and User’s Guide CD-ROM using the Borderless Printing mode.

Note Media Types Suitable for Borderless Printing

Media Types compatible with Borderless Printing include
Photo Paper Plus Glossy (LTR, 4" x 6"), Photo Paper Pro (LTR),
Matte Photo Paper (LTR), and Glossy Photo Paper (LTR).

Follow the simple steps below to create prints of digital camera photographs with Easy-
PhotoPrint using the Borderless Printing function. Easy-PhotoPrint supports Exif Print (Exif

2.2).

12

¢ Exif Print (Exif2.2) is a new worldwide standard. Under Exif2.2, the digital camera

can record data tags for specific camera settings and functions such as whether the
flash was on or off, if the camera was in portrait or night scene mode, etc.

BJ Printers support Exif Print and use Easy-PhotoPrint to read camera data
precisely, producing optimal prints.

This enables you to create prints that reproduce your vision more accurately than
ever before.

¢ Easy-PhotoPrint can handled only JPEG files (filename extension: .jpg and .jpeg).

Start Easy-PhotoPrint.
(1) Insert the memory card in the computer.

This chapter describes only the steps used for printing the photographs stored
in the card as an example. We recommend you consult your memory card
documentation for instructions on how to set the memory card in the
computer.

(2) Click Start, select All Programs (or Programs), Canon Utilities, Easy-PhotoPrint,
and then Easy-PhotoPrint.
The 1.Image Selection sheet is displayed.
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2 Select photographs.

(1) Select the folder containing the photograph you want to print. (Select memory
card folder, then the folder containing the digital photographs.)
All photographs in the selected folder are displayed.

5
Ele iew Help
e .
ot First select the folder which containg JPEG images.
3 SR = e o oo M - Guidance
a Otlo When all the settings are finished, click the "2, Paper Selection’” tab.

AT 0004

AT 0003

AT o0z

i ——— Thumbnail
< Local Disk (02)
2 D Drive (€5}
[ e MEMORYCARD (F:)
Yo
{3) Desktop Folder

= o+

AT 0008

) Thevalumesattin
| Shared Documents
{5 My Documents

543 My Network Flaces

Folder window

N

+ 456 Media Type: Photo Paper Pro | 0Pags (5)

(2) Click the [+] button on the thumbnail of the photograph you want to print and
specify the number of copies.

The number of copies increases.
The specified number of copies displayed.

The number of copies decreases.

13
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3 Select the paper.

(1) Click the 2.Paper
Selection tab.

Priter [Caronicsn 4 I™ Vivid Photo

I~ Photo Noise Reduction

(2) Select the size of the
paper you use from
Paper Size.

(3) Select the type of the
paper you use from

per Size : 4x6 Media Type : Photo Paper Fro M ed ia Typ e .
i it (1) Click the 3. Layout/
Ratate Ra%e Tuﬁg ' Print tab.

Left Fight

(2) Select Borderless(full).

(3) Load the media type specified in the 2.Paper Selection tab.
(4) Click Print.

14
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Printing photographs with Macintosh

This chapter describes only the steps used to print from photo applications included with
your Setup Software and User’s Guide CD-ROM using the Borderless Printing mode.

Note Media Types Suitable for Borderless Printing

Media Types compatible with Borderless Printing include
Photo Paper Plus Glossy (LTR, 4" x 6"), Photo Paper Pro (LTR),
Matte Photo Paper (LTR), and Glossy Photo Paper (LTR).

Follow the simple steps described below and learn how to create color prints of digital
camera photographs with ImageBrowser using Borderless Printing.

Exif Print (Exif2.2) is a new worldwide standard. Under Exif2.2, the digital camera can
record data tags for specific camera settings and functions such as whether the flash was
on or off, if the camera was in portrait or night scene mode, etc.

B) Printers support Exif Print and use ImageBrowser to read camera data precisely,
producing optimal prints.

This enables you to create prints that reproduce your vision more accurately than ever
before.

1 start ImageBrowser.

(1) Insert the memory card in the computer.

This chapter describes the steps used for printing the photographs stored in
the card. We recommend you consult your memory card documentation for
instructions on how to set the memory card in the computer.

(2) Double-click the Canon ImageBrowser (alias) icon on the desktop.

If the Canon ImageBrowser icon is not displayed on the desktop, open the
Canon ImageBrowser folder, in which the ImageBrowser program has been
installed, and double-click the ImageBrowser icon in the folder.

15
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2 Select photographs.

(1) Select the folder containing the photograph you want to print. (Select memory
card folder, then the folder containing the digital photographs.)

All photographs in the selected folder are displayed.

=]

(2) Click the photograph
you want to print.

~ & oo
W 100CANIN
Q canomse fsosazs

(3) Click PRINT and select
Layout printing from
the pull-down menu.

AUT_0006.JPG

AUT_0004.JPG AUT_0005.JPG

aaaaaa

vvvvv

The Layout Options dialog box appears and layout selection wizard starts.

3 Enter layout options.

Layout Options

How would you like to print your photos?

(3 Custom layout printing

3 Index printing

(3 Fixed photo size printing

—— (1) Select Tiled photo printing.

@ Tiled photo printing

() Canon perforated paper printing

Specifies the number ofimages per page
and prints. Images are tiled on the page
to allow them to be printed as large as
possible.

[ Display this dialog when the Printing window displays

L (2) Click Next.

v

16
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Layout Options

— Preview

Confirm the page setup and select the
number ofimages per page.

Paper size :
Vertical279.4 X Horizontal215.9mm

( ) — (3) Click Page setup....
.ofimages i

[ Automatic Clipping:

SetPhoto Area...

[ Display this dialog when the Printing window displays

Cancel ] [ ¢ Back ] [ 0K ]

Select Borderless Printing.

(1) Select Borderless Printing by

s F— clicking the check box.
vanep size (([Tetier D—— (2) Select a paper size from the
panner Printn [comcel_J Paper Size pull-down menu.
= & Borderiess Printing The menu only displays those
L Amountetitensen: paper sizes compatible with

Borderless Printing.
Scale: @ %

Height:11.00 Width :5.500
o L - S Orientation : T

[ Save Settings

(3) Click OK.

A message box pops up, displaying the information about printing. Read the
message and click OK.
This returns you to the Layout Options dialog box.

17
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5 Specify the number of photographs to print on one page.

Layout Options

— Preview

Confirm the page setup and select the
number of images per page.

Paper size :
Vertical1524 X Horizontal 101.6mm
Page setup...

No.ofimages

@)} el : '3_ E (1) Select 1(1x1) from the No.

[ Automatic Clipping: 5 of images pu“-dOWn men u.

[ Display this dialog when the Printing window displays

e ) (e (o _)H— (2) Click OK.

6 Print the photograph.

0

Print

Eelel
=]
IMAGES
RE-LAYOUT  ROTATE. oo cage

i

LavouT
OPTIONS:

(1) Click PRINT.

The Print dialog box is displayed.

18
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Canon i850 — Version 4.1
Copies: D m
e om0 [
BJ Cartridge :
[ cotor 2]
Media Type ] | (2) Select a type of media for
[Phutn Paper Pro i] . . .
— printing from the Media Type
Letter [BataFeeuey =) pull-down menu.
e (oo ) —1— (3) Select Photo from the Print
Mode pull-down menu.

(4) Load the selected paper in the printer.
(5) Click Print.

Accessing Printer Driver

The Printer Properties dialog box can be opened from either within an
application, or directly from the Windows Start menu.

Note @ This manual refers to Windows XP operation.
The operations may vary depending on your operating
system.
® Depending on your application program, the command and
menu names may differ, and there may be more steps
involved in opening the Printer Properties dialog box. For
further details, see the user's manual for your application.

B Opening the Printer Properties dialog box from your application
program

1  Inyour application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File menu.

2 Ensure that Canon i850 is selected. Then click Preferences (or Properties).

The Printer Properties dialog box opens.

19
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B Opening the Printer Properties dialog box directly from the Start

20

menu

This method is used for maintenance operations such as print head cleaning, or to
specify printer settings common to all application programs.

When the Printer Properties dialog box is opened from the Start menu, additional tabs
appear, including the Details tab. These do not appear when the Printer Properties
dialog box is opened from within an application.

For further information about these additional tabs, refer to your Windows
documentation.

Click Start and select Control Panel, Printers and Other Hardware, and then
Printers and Faxes.

For non-XP Windows, Click Start, select Settings, and then Printers.

Select the Canon i850 icon.

Open the File menu and select Printing Preferences (or Properties).

In Windows NT 4.0, select Document Defaults....

The Printer Properties dialog box opens.
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Adjusting Print Quality for Photographs

B Improving Printed Images
Two important factors control the quality and output of your printed images:

Paper and Ink

Using recommended Canon paper, specialty media and inks for printing
photographs can significantly improve the quality of your printouts. See the inside
back cover for a list of Canon media and inks for this printer.

Printer Driver Settings

The printer driver has a variety of settings that can be used to creatively enhance the
colors and output of your photographs. Many of these features are covered in this
chapter.

For more detailed information, see the i850 User's Guide on the Setup Software &
User's Guide CD-ROM.

You can also access the online help in one of the following ways while in the printer
driver interface:

(Windows|

e Press the F1 key
e Click ? in the upper right corner, then click the feature you want to know more about.
e (Click the Help button when displayed.

e Turn on Balloon Help by clicking Help, then Show Balloons.
B Adjusting Print Quality

Features that affect the appearance and quality of your printed images can be
controlled with the printer driver.

The i850 automatically adjusts printer settings to improve print quality based on the
media type (plain paper, Photo Paper Pro, and so on). You can also customize the Print
Quality settings if desired.

21
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To manually adjust Print Quality settings:

(Windows

22

1

Open the Printer Properties dialog box.

See"Opening the Printer Properties dialog box from your application program"
on page 19

Select Custom in Print Quality, then click Set... to open the Set Print
Quality dialog box.

Move the slide bar to adjust the Print Quality.

Set Print Quality

Fine
Haltoring “ g
Auto

Diffusion

Qualiy Standard 3 _J_ @
Fast

[ Reduce spool data size

0| [ cancel | [ Hek

When done, click OK.

Open the Print dialog box.

See "Printing with Macintosh" on page 9

Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

Move the slide bar to adjust the Print Quality.

Canon Detailed Setting

. Print Quality:  Fast e===——==i== Fine
....... i :

Spectal affects :
....... . =l
ccccc "

Diffusion
|| (Restore Defaults

When done, click OK.
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To automatically optimize the image:

Photo Optimizer PRO automatically adjusts a photographic image created with a digital
camera. Use this feature to compensate for unsatisfactory color balance and over- or
under-exposure before printing.

(Windows

1

S W N

£~ N R

Open the Printer Properties dialog box.

See"Opening the Printer Properties dialog box from your application program"
on page 19

Click the Effects tab.
Select the Photo Optimizer PRO check box.

b pri

Open the Print dialog box.
See "Printing with Macintosh" on page 9

Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

Click & (Special effects).
Select the Photo Optimizer PRO check box.

Canon Detailed Setting

[ simulate illustration

= —=3

23
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5 click OK.
To use Vivid Photo option:

Vivid Photo intensifies background colors for fields, trees, oceans and skies, while
maintaining natural skin tones in the images.

Note InWindows Me, Windows 98 or Windows 95

The Vivid Photo function will not be available if Background Printing
has been disabled.

To use Vivid Photo, select the Vivid Photo check box on the Effects tab.

& printing Preferences.

3 Main | £ PageSetup| &)

| o# Ettects [ Profles | i Mairtenance,
[ Simulate llustration

[ Monochrome Effects:
Sepia
Pink

5

Select Color

4 ]
(’yw.d Bhai)
Effects: an
DlinogOptrice

[ Phato Optinizer RO

Apply Thioughout Page

[ Photo Noise Reduction

Canon Detailed Setting

To use Vivid Photo, select the Vivid Photo check box in the Special Effects.

[ Simulate illustration

Contrast: gy

DIMonochrome erfects

[ vivid an)

[ Photo Optimizer PRO

[ Apply Throughout Page
[0 Photo Noise Reduction :

0|

Restore Defaults
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To reduce noise from images recorded with digital camera:

Photo Noise Reduction function reduces noise from blue portions such as the sky
and dark portions of the images recorded with your digital camera.

Note InWindows Me, Windows 98 or Windows 95

The Photo Noise Reduction function will not be available if

Background Printing has been disabled.

'Windows

To use Photo Noise Reduction, select the Photo Noise Reduction check box on the

Effects tab.
& printing Preferences [B]
S Main | & PageSetup| & | o# Ettects [ Profies | i Maintenance |
[ Simulate llustration
[ Monochrome Effects:
Sepia Blue
Pink Grea
Select Cola
[ vivid Photo
El [ image Optimi
EI [IPhgto 0y
Ao i Page
(EI Phots Noise Heduchion [Momal vD

Macintosh|

To use Photo Noise Reduction, select the Photo Noise Reduction check box on the

Special Effects.

Canon Detailed Setting

[ Simulate illustration

Contrast: gy

CIMonochrome effects:

[0 Photo Optimizer PRO
[ Apply Throughout Page
Photo Noise Reduction :

Normal B

DT

Restore Defaults

(o) o)

25
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B Saving and Recalling Driver Settings

When you change printer driver settings for a specific print job, such as printing
black and white photos, or printing documents with a special background, you can
save and name these settings for future use on similar print jobs.

(Windows

26

1

N

(9 )

Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box from your application
program" on page 19

Click the Profiles tab.

Enter new settings in Profiles.

— (1) Click Add to Profiles.

. — (2) Enter the name of profile for
BEE0WE DjJ] registering settings.

- | (3) Select an icon.

(4) Enter description on the
registering profile.

Click OK.

Click OK on the Profiles tab.

This registers your printer driver print settings.

Note You can retrieve or delete the print settings profile at any time.
Retrieving profile:
Select the desired profile from Printing Profiles and click
Retrieve from Profiles.
Deleting unwanted profile:
Select the desired profile from Printing Profiles and click Delete.
For details, click Help and refer to the topic of this function.
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19

Open the Print dialog box.

See "Printing with Macintosh" on page 9

Click Apply.
The Register Settings dialog box opens.

Enter the print settings to register.

Canon Register Settings

Settings :
wFactory Defaults

DI

Defaults... | [Remove..{ [CApply.. ])— (1) C“Ck Apply....

The dialog box to enter the new settings name opens.

New Settings Name :
Unknown —H— (2) Enter a name under which
cancel | [ ok ) to register your settings.
Click OK.

Click Close in the Register Settings dialog box.

This registers your printer driver print settings.

Note You can retrieve or delete the saved driver settings at any time.

Retrieving print settings:
Select the name of the settings to retrieve from the Settings list
and click Import.

Deleting unwanted drivers settings:
Select the name of the settings to delete from the Settings list
and click Remove.
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Using Printer Driver Options

Getting to know the basic features of your printer driver will provide you with
sufficient expertise to print a wide range of images and documents.

The illustrations below provide a basic introduction to the many features
offered by your printer driver.

Note For detailed description of the printer driver functions, refer to
the User’s Guide.

Reducing Noise from Images Recorded with
Digital Camera

Images Page

Adding Illustrated Effect to Documents
Resizing the Image by Selecting the Scaling

Ratio
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Printing Maintenance
Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully.
The printer will not print properly if the wrong ink tank is used, or installed in
the incorrect position.

With this printer, ink tanks must be installed from the right in the order indicated below.

Yellow: BCI-3eY
Magenta: BCl-3eM
Cyan: BCl-3eC
Black: BCI-3eBK

B Knowing When to Replace Ink Tank

If an ink tank needs replacing, as soon as printing begins, the POWER lamp will change
from green to orange and flash four times. It is important to quickly identify the empty
tank using the BJ Status Monitor (Windows) or error messages (Macintosh) and replace
it.

Note Should missing characters or white streaks appear despite

sufficient ink levels, refer to the section "When Printing
Becomes Faint or Colors are Incorrect” on page 34
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(Windows|

The following message appears when ink is empty. Printing will resume as soon as ink tank
is replaced and the front cover is closed.

Canon i850 - USB0O01

— The ink tank with [X] symbol is out of ink.
Ink hias run out. . N
Replace ink tank and closs the front cover Rep[ace Wlth anew mk tank_
“You can continue printing under the ink out
condition by pressing the RESUME button.
Rieplace the smpty ink tank immediately
e * Press the RESUME/CANCEL button to
il condien resume printing with an empty ink tank.
e When printing is finished, replace the ink
tank immediately. If you continue
printing with an empty ink tank, it will be

a cause of trouble.

e Menu screens will vary to some degree,
depending on your software
environment.

Empty ink tank

Note When Low Ink is Detected
The BJ Status Monitor appears as soon as a print job starts.

['] Indicates ink low. Obtain a replacement tank as soon as
possible.

(i) Canon 1850 - USBOOT
Option  Help

Fiirter Status |

Pinting

The fallowing ink tanks are runiing low. o Cl|Ck Cancel Pl’intingto
Voaene cancel the current
print job
e I Tank with low ink level

Dwner. default
Document Name:  Document
Printing Pages: 11

Cancel Printing | | Display Print Queus
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The following message is displayed when ink tank is empty.

Printing will resume as soon as ink tank is replaced and the front cover is closed.

A

i850 Error Number:D1612

The magenta ink has run out. Open the
printer front cover and load a new ink tank.
When this is completed, close the front
cover.

Note When Low Ink is Detected

¢ Press the RESUME/CANCEL button to

resume printing with the ink tank
empty. When printing is finished,
replace the ink tank immediately. If
you continue printing with an empty
ink tank, it will be a cause of trouble.

The following message is displayed as soon as a print job

starts.

['] Indicates ink low. Obtain a replacement tank as soon as

possible.

Canon 850

Version 4.1

Document Name : Document
Printing Pag
Printin

Ink level ! @u

1 Copies

(41%)

The following ink is running low.
Magenta

Tank with low ink level
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B Replacing Ink Tanks
When ink tanks run out of ink, replace them using the following steps.

1  Ensurethatthe printer is on, and then open the front cover.

The print head holder moves to the center.

2 Remove the empty ink tank.

(1) Push the tab and remove the ink tank.
r’;ﬁf\ NN

Do not touch the
lock lever; remove
only the ink tank.

Important ® Handle ink tanks carefully to avoid staining clothing or the
surrounding area.
® Discard empty ink tanks according to the local laws and
regulations regarding disposal of consumables.

3 Prepare a replacement tank.

(1) Unpack the new ink tank and pull off the orange tape.

(2) Remove the orange protective cap from the bottom of the ink tank and discard
it.
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Important ® Do not squeeze the side of ink tanks as this may cause the
ink to leak out and stain your clothes and hands.
® Do not re-attach the protective cap once you have removed
it.
® Once the protective cap is removed, do not touch the open
ink port.

Install the ink tank.

(1) Insert the ink tank in the print head holder.
(2) Press on the "PUSH" mark until the ink tank snaps firmly into place.

Close the front cover.

The print head holder moves to the right. The ink tank installation process is now
complete.

Note @ To maintain optimal Print Quality, use an ink tank within six

months of first use.

® Once an ink tank has been used, do not remove it from the
printer and leave it out in the open. An ink tank left out in
the open and then reinstalled in the printer may not
function.

® Colorink consumption may occur even when black-and-
white or grayscale printing is specified.
Colorink is consumed in the head cleaning and deep
cleaning, which are necessary to maintain the printer’s
capabilities.
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When Printing Becomes Faint or Colors are Incorrect

When printing becomes faint or colors are incorrect, even if ink remains in
the ink tanks, see if the print head nozzles are clogged and clean them first.
Follow the procedures below and maintain the print head.

Important Before maintaining the print head, check the following;

® Open the front cover and make sure whether the ink tank contains
ink. If it is out of ink, replace it.

® Ensure that all the orange tape of the ink tank has been peeled off.

® Press "PUSH" on the ink tank and ensure that the ink tank is
installed securely.

® Increase the Print Quality setting in the printer driver settings.

"Printing the Nozzle Check Pattern" on page 35

If the print quality is poor If white stripes are noticeable

v v
Step 2
"Aligning Print Head" on page 42

Step 2
"Print Head Cleaning" on page 37

If the problem remains

v

Step 3
“Print Head Deep Cleaning" on page 40

@ Note If print head maintenance does not resolve the problem, contact
the Customer Care Center.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects normally
from the print head nozzles, and to verify print head alignment. Use this
function when printed results are blurred or the color is incorrect.

(Windows|

With the printer on, load a sheet of Letter paper in the printer.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box directly from the Start menu" on
page 20

3 Print the Nozzle Check Pattern.

& Canon i850 Printing Preferences

5 Main| 5 Page Setup | @) StampBackground | o# Effects | (3 (Profiles| dl} Maintenance | E— (1) C“Ck the Maintenance tab.

(2) Click Nozzle Check.

0k [ Concel ] Help

(3) When the confirmation message is displayed, click OK.
See "Examining the Nozzle Check Pattern" on page 37
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With the printer on, load a sheet of Letter paper in the printer.

2 Open the Printer Utility dialog box.
(1) Select Page Setup... in the File menu
(2) Click Utilities to open the Printer Utility dialog box.

3 Print the Nozzle Check Pattern.

‘Canon i850 Printer Utility Version 4.1
est Prin = ) o
r 2 (1) Select Test Print from the
No;:il:t?.'aerf:zzle-check pattern. pu l-down menu.
L .

et Hoad Algrment (2) Click Nozzle Check.
It will align the print heads to correct any
errorin their installation position.

Coose )

(3) When the confirmation message is displayed, click OK.
See "Examining the Nozzle Check Pattern" on page 37
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B Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly.
Examine the nozzle check pattern output by the printer.

— (1) Lines missing here indicate the print
head requires cleaning.

See "Print Head Cleaning" on page 37

AY4

A B [ D E N\
0 ol o 0 0 . . .
< (2) Unevenness in these patterns indicates

I J

o omm oW - ’ — the print head requires alignment.

\\

( . ) - ’ See "Aligning Print Head" on page 42

~ (3) Horizontal stripes in these patterns
indicate the print head reguires alignment.

See "Aligning Print Head" on page 42

Print Head Cleaning

Clean the print head if you suspect that the nozzles might be clogged.
Cleaning the print head consumes ink, so perform print head cleaning only

when necessary.
1 Ensurethatthe printer is on.
2 Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box directly from the Start menu" on
page 20
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3 Start Print Head Cleaning.

& Canon i850 Printing Preferences

5 Main| £ Page Setup | ®) StamprBackgr Efects | (3 Profies| b - (1) Click the Maintenance tab‘

(2) Click Cleaning.

0k [ Concel ] Hepp

(3) Select the ink nozzles to be cleaned, and then click Execute.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

(4) When the message is displayed, click OK.

Ensure the printer is on.

2 Open the Printer Utility dialog box.

(1) Select Page Setup... in the File menu.
(2) Click Utilities to open the Printer Utility dialog box.
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3

Start Print Head Cleaning.

Canon i850 Printer Utility Version 4.1
—{[creaning ﬂ) (1) Select Cleaning
anin from the pull-
“ Stnrtsgprint-head cleaning. down mell:')] u.

Deep Cleaning
Starts print-head deep cleaning. L . .
(2) Click Cleaning.

CoosJ

(3) Select the ink nozzles to be cleaned, and then click OK.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

(4) When the message is displayed, click OK.

Important Do not perform any other operations until the print head
cleaning finishes. This takes about 50 seconds.

@ Note @ Print head cleaning can be performed also from the printer
itself. Ensure the printer is on. Hold down the RESUME/
CANCEL button until the POWER lamp flashes once.
® After print head cleaning finishes, print the nozzle check
pattern to verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 35
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Print Head Deep Cleaning

If print quality does not improve by standard print head cleaning, try print
head deep cleaning, which is a more powerful process. Print head deep
cleaning consumes ink, so perform this procedure only when necessary.

(Windows|

Ensure the printer is on.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box directly from the Start menu" on
page 20

3 Start Print Head Deep Cleaning.

& Canon iB50 Printing Preferences.

© Main| 2 Pageseun| @) stamp/Backgiound | 8 Effects | (3 Frofifs| M Maintenance

(1) Click the Maintenace tab.

(2) Click Deep Cleaning.

Pint Head Alignment Nozele Check

(3) Select the ink nozzles to be cleaned, and then click OK.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

(4) When the message is displayed, click OK.
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1 Ensurethe printer is on.

2 Open the Printer Utility dialog box.

(1) Select Page Setup... in the File menu.

(2) Click Utilities to open the Printer Utility dialog box.

Start Print Head Deep Cleaning.

Canon i850 Printer Utility

Version 4.1

AG Cleaning i])

Cleaning
Starts print-head cleaning.
ﬂ Deep Cleaning
Starts print-head deep cleaning.

(1) Select Cleaning

from the pull-
down menu.

(2) Click Deep

Cleaning.

(3) Select the ink nozzles to be cleaned, and then click OK.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

(4) When the message is displayed, click OK.

Important The process takes one or two minutes to complete, so simply
wait until the POWER lamp stops flashing.

@ Note After print head deep cleaning finishes, print the nozzle check
pattern to verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 35

If the print head is still not clean after the second deep
cleaning, the print head may be worn out. In this event, contact
the Customer Care Center.
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Aligning Print Head

(Windows|

With the printer on, load a sheet of Letter paper in the printer.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box directly from the Start menu" on

page 20

3 Print the pattern.

Custom Settings

% Start Status Monitor

0k J[ Concel | il

]

Did the pattern print successfully?

\?/
IF nithing was printed, of I the: pattern is noticeably Faint or patchy, click Mo and try again,

42

(1) Click the Maintenance tab.

(2) Click Print Head Alignment.

(3) When the confirmation message
is displayed, click OK.

(4) After the pattern is
printed, click Yes.



Printing Maintenance

4 Align the Print Head.

(1) Look at the print-out. From the patterns, select the most even, least irregular
patterns and enter the number that corresponds.

Print Head Alignment (&3]
.
lect the

ing ta the patiems
ihat shows no flavs.

Piint head
printed in c

Horizontal Alignment (2
Column
Column

Column

(2) Enter the numbers.

Column

N

C=R =

Column

Bi-diectiona
Column

=
2

T ® m e

Column
Column
Column

Column

= oe

Column

) e (3) Click OK.

Note [fthisis difficult to pick up the best pattern on Column K, pick
the setting that procedures the least noticeable vertical white
stripes.

Less noticeable white stripes More noticeable white stripes

(4) Click Cancel.

=E Note Click OK to perform even more detailed adjustments.
S If streaks appear on the printed surface when you use the
printer, follow the procedure below to adjust the printing.

1. Check that the paper that you normally use is set in the
printer, and then click OK.

2. Select the best patterns from Columns G and H, enter their
numbers, then click OK.
The best patterns will be smooth and have no streaks in
the border indicated by the arrows.

—
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Ensure the printer is on.

2 Open the Print Utility dialog box.
(1) Select Page Setup... in the File menu.
(2) Click Utilities to open the Printer Utility dialog box.

3 Print the pattern.

Canon i850 Printer Utility Version 4.1
{TestPrint iD (1) Select Test Print from
Nozzle Check the pull-down menu.
Prints a nozzle-check pattern.

@ Print Head Alignment
Itwill align the print heads to correct any

error in their installation position.

(2) Click Print Head Alignment.

oo

4 Align the Print Head.

(1) Look at the print-out. From the patterns, select the most even, least irregular
patterns and enter the number that corresponds.

Print Head

Print head alignment is being executed. Referring to the
patterns printed in columns A to K, select the pattern that
shows no flaws.

Adjust si
ColumnA:

w
3

(2) Enter the numbers.

ColumnB:

Column C:

LT

ColumnD:

E E EE E i

ColumnE:
Adjust both way:
ColumnF:

A
&
g

@JQEEEEE;

Column G:
ColumnH:

7 Column |

Column J:

ColumnK:

=
&
=
-

(3) Click Send.

Note [fthisis difficult to pick up the best pattern on Column K, pick
the setting that procedures the least noticeable vertical white
stripes.
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Less noticeable white stripes More noticeable white stripes

Basic print head alignment is complete. You
can print normally.

To finish the alignment, click [Cancel].

If streaks appear on the printing side, you
can prevent them from appearing by
aligning the print head. To proceed to this
alignment,insert a sheet of paperinto the
sheetfeeder and click [0K].

L (4) Click Cancel.

Note Click OKto perform even more detailed adjustments.
If streaks appear on the printed surface when you use the
printer, follow the procedure below to adjust the printing.

1. Check that the paper that you normally use is set in the
printer, and then click OK.

2. Select the best patterns from Columns G and H, enter their
numbers, then click OK.
The best patterns will be smooth and have no streaks in
the border indicated by the arrows.

(5) Click Close.
(6) Click OK.
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Troubleshooting

This section provides troubleshooting tips for the most common printing
problems. Troubleshooting usually falls into one of the following categories.
Refer to the User's Guide for additional information on topics not covered in
this section.

46

“Cannot Install the Printer Driver" on page 47

“Print Quality is Poor or Contains Errors" on page 48
"Troubleshooting Printer Hardware" on page 50
"Paper Does Not Feed Properly" on page 51

"Handling Error Messages" on page 52

“An Error Message Appears on the Screen" on page 53

Rl Windows |

When error occurs

The BJ Status Monitor opens and displays a message when
an error occurs. Take the appropriate action described in the
message.

The message may vary depending on your operating system.

o
Cancel Printing | | Display Print Queue:

When using Windows Me, Windows 98 or Windows 95, click
the Guide tab and follow the on-screen instructions.
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Cannot Install the Printer Driver

Problem

CannotInstallthe
Printer Driver

Possible Cause ‘

Installation
procedure not
followed correctly

Try This

Follow the installation instructions from the £asy Sefup Instructions packaged
with your printer.

Windows|
Note If the installer was forced to terminated due to an error,
Windows may be unstable. Remove the CD-ROM from the CD-
ROM drive and restart the computer. Try reinstalling the printer
driver.

If the problem persists, refer to your Windows documentation
for more information.

Other applications
running in the
background

Other open applications on your computer can interfere with the installation
routine. Close all open software applications before reinstalling the printer driver.
Refer to the £asy Setup Instructions for installing the printer driver.

Installation does
not start
automatically when
the CD-ROM is
inserted into the
drive

o

If printer driver installation did not start automatically when you inserted the CD-
ROM into the CD-ROM drive:

1. Click Start and select My Computer.
2. Double-click the CD-ROM icon.

For non-XP Windows, open the My Computer window, and then double-click the
CD-ROM icon.

Double-click the CD-ROM icon on your desktop to start installation.

Installation CD-
ROM not working

properly

Confirm that there are no problems with the Setup Software & User’s Guide CD-
ROM.

‘W,
Use Windows Explorer to confirm that the CD-ROM can be read.

Confirm that the CD-ROM icon is displayed on the desktop.
If there is any problem with the CD-ROM, contact the Customer Care Center.

Unable to proceed
beyond the Printer
Port screen

Reinstall the printer driver
1. Click Cancel.

When the Terminate Installation screen
is displayed, click OK.

. Click Exit, then remove the CD-ROM.
. Turn the printer off.

Fotowtis ocede 2.
1-Chock tat thoca

. Restart the computer.

[<)NNNC . B OV}

. Carefully follow the procedures
described in the Fasy Setup
Instructions and reinstall the driver.
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Print Quality is Poor or Contains Errors

Problem

Ink does not
come out/
Printing is
Blurred/ Colors
are Wrong /
White Streaks

Possible Cause |
Ink tank is not
seated properly/Ink
tank is empty

Try This
Check that the ink tanks are firmly seated in the print head and reseat them if
necessary.

® Checkto seeif all the orange tape has been peeled off as shown in (1). If there
remains a part of the orange tape as shown in (2), remove it thoroughly.

If ink tank is empty: See"Replacing an Ink Tank" on page 29

Media not loaded
print-side up

Check that your paper is loaded with the correct print side facing up.

Note  Follow the instructions packaged with your specialty media for

loading and handling.

Incorrect paper N/

type On the Main tab, confirm that the Media Type selected matches the paper loaded.
In the Print dialog box, confirm that the Media Type selected matches the paper
loaded.

Print head is Adjust the print head location.

displaced. See "Aligning Print Head" on page 42

Print head is Print the nozzle check pattern to check for uneven ink output.

clogged. When a specific color is missing from the nozzle check pattern, clean the print

head.
If ink supply is uneven: See "Print Head Cleaning" on page 37

Note  The ink tank may be clogged with dust or air if the protective

cap is replaced after the removal.

Print Quality not set
properly

Be sure to set the Print Quality setting to High.

‘W,
On the Main tab, click High for the Print Quality setting.

1. Select Manual in the Print Mode pull-down menu in the Print dialog box and
then click Details.

2. Click the Quality icon and then drag the Print Quality slide bar to the Fine end.
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Problem

Printed Paper
Curls or Ink Blots

Possible Cause |

Printed paper too
thin

Try This

Use High Resolution Paper or Photo Paper Pro to print images that require a lot of

ink (i.e. pictures with intense colors or photographs).

Color Intensity
setting is too high

Reduce the Intensity setting in the printer driver and try printing again.
‘W
1. Open the Printer Properties dialog box.

2. On the Main tab, select Manual for Color Adjustment, and then click Set.

3. Drag the Intensity slide bar to adjust the intensity.

1. Open the Print dialog box.
The Print dialog box can be opened by selecting Print in the File menu.

2. In the Print Mode pull-down menu, select Manual and then click Details.

3. Click the Coloricon, then drag the Intensity slide bar to set the intensity.

Paper feed roller is
dirty

Clean the paper feed roller.
See "Paper Does Not Feed Properly" on page 51

Printed Surface is
Scratched

Inappropriate
paper type used

Check to see if the paper you are printing on is too thick or curled.
See "Print Media to Avoid" on page 3

Note that smudging may occur at the top and bottom edges of the paper when
using Borderless Printing. Make sure that the paper you are using is compatible

with Borderless Printing.
See "Media Types Suitable for Borderless Printing" on page 12

Incorrect position
of the paper
thickness lever

When printing on thick paper, set the paper thickness lever to the “ =1 ”"mark.
This widens a gap between the print head and the paper. If the paper is scratched

even when printing on plain paper, also try this.
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Troubleshooting Printer Hardware

Problem

Printer Does Not
Start or Printer
Stops During
Print Jobs

Possible Cause ‘

Print head has
overheated due to
long periods of
continuous printing

Try This

Stop printing and turn the printer off for at least 15 minutes to allow the print head
to cool down.

The print head tends to overheat when printing continuously for long periods of
time. The print head is designed to automatically pause at line breaks before
resuming printing in order to cool down.

Caution The area around the print head can become extremely hot
during extended print operation. Always avoid touching the

print head and its peripheral components.

Printing high-
resolution
photographs and
graphics

Wait until the print job finishes.

The POWER lamp flashes green while the print data is being processed. Printing
photographs and high-density graphics can take time.

Printer cable is too
long

Avoid using printer (parallel) cables longer than 6.5 feet and USB cables longer
than 16.4 feet.

There may be
problems in your
operating system

Restart your computer. It may solve the problem.

Delete an undesired print job if there is any. Use B) Status Monitor in Windows or
BJ Print Monitor in Macintosh for the deletion.

‘W,
1. Open the Printer Properties dialog box.

See "Opening the Printer Properties dialog box directly from the Start menu"
on page 20

2. Click Maintenance tab and then Start Status Monitor.
3. Click Display Print Queue.

4. Select Cancel All Documents in the Printer menu.
Click Yes when a confirmation message appears.
The print job is deleted.

Note In Windows Me, Windows 98 or Windows 95

Click to select an undesired document and select Purge Print
Documents in the Printer menu.

1. Double-click BJ Print Monitor in the Extensions in the System Folder.

2. Click to select an undesired document and click [&].
The print job is deleted.

Cannot Print to
End of Job

Incorrect page size
selected

Verify that the page size setting matches the size of the paper loaded in the
printer:

- Check the Paper Size setting from within your application to ensure that it
matches the size of the paper load.

- Check the Page Setup tab in the Printer Properties dialog box (for Windows) or
the Page Setup dialog box (for Macintosh) to ensure that it matches the size of
the paper loaded.

Not enough free
space on hard disk

Your operating system may be out of free disk space.
Check the available space on your computer’s hard disk.
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Paper Does Not Feed Properly

Problem

Paper Does Not
Feed Properly

Possible Cause ‘

Inappropriate
paper type used

Try This
Check to see if the paper you are printing on is too thick or curled.
See "Print Media to Avoid" on page 3

Paper feed roller is
dirty

Follow the steps described below to clean the paper feed rollers.

If envelopes or post cards do not feed properly, even after correcting any paper
curl, clean the paper feed roller.

1. Ensure the printer is on and there is no paper loaded in the printer.

2. Hold the RESUME/CANCEL button down and release after the POWER lamp
flashes three times.
The paper roller rotates as it cleans.
Repeat this cleaning operation three times.

3. Load a sheet of Letter sized plain paper in the printer.

4. Hold the RESUME/CANCEL button down and release after the POWER lamp
flashes three times, then feed the sheet of paper.
Repeat this operation three times.

If the printer still does not feed the envelopes or the post cards properly through
the printer, even after the cleaning operation, repeat the procedures.

Paper Jams

1. Gently pull the jammed paper out of the sheet feeder slot or the paper output
slot, whichever is easier.

eIf the paper tears and some of it is left in the printer, turn the printer off, then
open the front cover and remove the piece of paper. Do not touch internal
parts in the printer. If you cannot reach or remove the torn paper, do not
attempt to disassemble the printer yourself. Contact the Customer Care
Center.

eIf you cannot extract the paper, turn the printer off, and then turn it back on.
The remaining paper will be ejected automatically.

2. Close the front cover and reload the paper into the paper rest, then press the
RESUME/CANCEL button on the printer.
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Handling Error Messages

When a printer error occurs, the POWER/ERROR lamp flashes. The number of
flashes indicate the type of error that has occurred. Count the flashes and
take the appropriate action to correct the error.

Note the number
of flashes
1

Green (lights =» Flashes =»> Green (lights =» Flashes
longer than orange) orange longer than orange) orange )Repeats

Number of Possible Cause Try This
flashes

Two flashes Indicates printer is | Reload paper and press the RESUME/CANCEL button.
out of paper

Three flashes Indicates paper jam | If a paper jam occurs, clear the jammed paper, reload paper in the printer, then

press the RESUME/CANCEL button. See "Paper Jams" on page 51

Four flashes Indicates empty ink | Press the RESUME/CANCEL button to resume printing with ink out condition.

tank Replace with a new ink tank immediately after the printing. It may damage the

printer if you continue printing with ink out condition.
See "Replacing an Ink Tank" on page 29

Six flashes Indicates printhead | Install print head. If print head is already installed, remove the print head and
not installed check the contacts for foreign matter, then reinstall.

After reinstall the print head, you may need to realign it.

Seven flashes Indicates defective | Remove the print head and check the contacts for foreign matter, then reinstall.

print head If the print head fails to work properly after reinstalling it, contact the Customer

Care Center.

Eight flashes Indicates waste ink | The printer has a built-in waste ink tank to hold the ink consumed during print
tank almost full head cleaning.

Eight flash indicates that this tank is nearly full.
Press the RESUME/CANCEL button to clear the error so printing can continue.
Contact the Customer Care Center.

Note POWER lamp flashes An error that requires contacting the Customer Care Center may have occurred.
alternately green and Turn off and unplug the printer from the power supply. Then plug the printer back
orange in and turn it back on. Should the problem persist, contact the Customer Care

Center.
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Troubleshooting

An Error Message Appears on the Screen

Problem
)
Error Writing /

Output to LPT1 or
USBxxx

Possible Cause
Printer not ready

Try This
The power lamp will flash green when the printer is warming up or when a print
job is being sent to the printer. It will glow a steady(non-flashing)green when it
is ready for use or when the print job is completed.

Paper is not
loaded.

Load paper and press the RESUME/CANCEL button.

Faulty connection

Ensure the printer cable is securely connected to the computer.

Note If you are using switching hub or other device, disconnect the
printer and reconnect it directly to the computer and try
printing again.

If successful, there may be a fault in the device.

There could also be a problem with the cable(s). Replace the

cable(s) and try printing again.

Printer driver does

Uninstall then reinstall the printer driver.

“Error No.: X202”

g?;;gflt;“ed 1. Click Start, select All Programs (or Programs), Canon i850, and Uninstall.
2. Follow the on-screen instructions to uninstall driver.
Follow the procedures described in the £asy Setup Instructions and reinstall
the printer driver.
Not enough Not enough memory for printing. Increase available memory by closing any
memory other applications currently running.

“Error No.: X203”

Printer driver fault

There is a problem with the printer driver. Uninstall, then reinstall printer driver.
Refer to the User’s Guidefor instructions on how to uninstall the printer driver.

“Error No.: X300”

Printer not ready

If the POWER lamp is off, turn the printer on.

If the POWER lamp is flashing green, the printer is initializing. Wait until the
POWER lamp stops flashing.

Printer not properly
connected

Ensure the printer is securely connected to the computer.

Note If you are using switching hub or other device, disconnect
the printer and reconnect it directly to the computer and try
printing again.

If successful, there may be a fault in the device.

There could also be a problem with the cable(s). Replace the

cable(s) and try printing again.

Printer not selected
in chooser

1. From the Apple menu, select Chooser.

2. Click the i850 icon and ensure i850 is selected as the target connection.
If not, select it.

Note If the problem persists, delete all unnecessary documents
from the Extensions and Control Panels folder.
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Appendix

User’s Guide Table of Contents

Your printer’s User’s Guide offers detailed information on the following topics.

How to Use This Manual
Printer Parts and Their Function

Useful Printing Techniques

Printing with Borderless Printing

Reducing Noise from Images Recorded
with Digital Camera

Achieving Vivid Reproduction of Images
with Lots of Greens and Blues

Printing with Color and Brightness
Automatically Optimized

Adjusting Print Quality

Smoothing the Rough Edges of Certain
Images

Automatically Resizing the Image to Fit
the Page

Resizing the Image by Selecting the
Scaling Ratio

Printing Multiple Pages on a Single Page

Enlarge a Document by Printing it on
Multiple Pages

Printing Multiple Pages for Assembly into
a Booklet

Printing on Both Sides of the Page

Printing Stamped Messages on
Documents

Printing Background Images on
Documents

Adding Illustrated Effect to Documents
Printing Entire Image in Single Color
Printing in Grayscale

Reversing the Page Printing Order
Printing on Nonstandard Size Paper
Reducing the Sound of Printer Operation
Registering Printer Driver Settings

Printing Media
Compatible Media Types
Envelopes
High Resolution Paper HR-101N
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Glossy Photo Paper GP-301N/GP-301
High Gloss Photo Film HG-201
Glossy Photo Cards FM-101

Photo Paper Pro PR-101

Photo Paper Pro PC-101S

Photo Paper Plus Glossy PP-101
Matte Photo Paper MP-101
Transparencies CF-102

T-Shirt Transfers TR-201

Banner Paper

Checking the Status of the Printer

BJ Status Monitor Functions

B) Backgrounder and B) Background
Monitor

BJ Printer Monitor
BJ Print Monitor

Troubleshooting

Cannot Install Printer Driver
Print Quality is Poor

Printer Does Not Start or Stops During
Print Jobs

Paper Does Not Feed Properly or Paper
Jams

The POWER Lamp Flashes Orange

An Error Message is Display on the Screen
Problems Unique to Windows

Problems Unique to the Macintosh

Appendix

Printing Area

For Faster Printing

Using the Printer with a Network
Uninstalling Printer Drivers
Uninstalling the User’s Guide
Transporting Printer

Printer Driver Functions(Windows)
Printer Driver Functions (Macintosh)
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Specifications

Printer
Printing resolution:

Print speed *
*Print speed may vary with the content of the

document and the pressing speed of the host

computer.

Print width:

Resident print control mode:
Receive buffer:

Interface (parallel):
Interface (USB):

Acoustic noise level:

Operating environment:

Storage environment:

Power supply:

Power consumption:

Dimensions
(without a paper rest and paper output tray
retracted):

Weight:

Graphic image printing:

Print Head:

4800 X 1200 dpi. max.

Black printing (text pattern)
Draft: 22 ppm
Standard: 13.0 ppm

Color printing
Draft: 14 ppm
Standard: 9.0 ppm

203.2 mm max. (8.0 in)
(for Borderless Printing: 216.0 mm/8.5 in)

Canon extended mode
248 KB

IEEE 1284-compatible
USB 2.0 Full Speed

Approx. 39 dB (A) (in the highest print quality mode)

Temperature: 5 to 35°C (41 to 95°F)
Humidity: 10 to 90%RH (no condensation)

Temperature: 0 to 40°C (32 to 104°F)
Humidity: 5 to 95% RH (no condensation)

Europe AC 230 V£10%, 50 Hz
USA/Canada AC 120V, 60 Hz
Australia AC 240V, 50 Hz

Standby: Approx. 0.7 W
Printing: Approx. 24 W

16.46 (W) X 10.79 (D) X 6.26 (H) in

Approx. 4.9 kg (10.8 lb.)

Data format:
Canon extended mode: Raster image format
Resolution:
Canon extended mode: 300, 600, 1200, 2400, 4800 dpi
Black: 320 nozzles (600 dpi)
Cyan, Magenta, Yellow: 256 nozzles (1200 dpi)
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Printer
Ink Tanks: Capacity (pages):
Black (BCI-3eBK) approx. 740*1, approx. 1500*2
Cyan (BCI-3eC) approx. 570*2
Magenta (BCI-3eM) approx. 440%*2
Yellow (BCI-3eY) approx. 380*2

*1 1500 characters per page, normal text, at standard and plain
paper mode with Windows XP

*2 Based on printing the 1SO JIS-SCID No.5 pattern at standard and
plain paper mode with Windows XP

BJ Printer Driver Systems Requirements

Windows|

® Use a computer on which Windows XP, Windows 2000, @ Use a Macintosh series computer equipped with USB
Windows Me, Windows 98, Windows NT 4.0 or Windows interface on which Mac OS 8.6 or later can operate.
95 can operate. ) . ® 30MB of available hard-disk space for printer driver

® USB* interface or standard 25 pin parallel interface installation

@ Available hard-disk space for printer driver installation
Windows XP/Windows 2000/Windows NT 4.0: 50MB
Windows Me/Windows 98/Windows 95: 15MB

* USB operation can only be guaranteed on a PC with pre-
installed Windows XP, Windows 2000, Windows Me, or
Windows 98. (This includes Windows XP, Windows 2000 or
Wind)ows Me upgraded from pre-installed Windows 98 or
later;

Additional Systems Requirements for User's Guide

® Pentium®, 75 MHz equivalent or higher processor (Pentium®, 133MHz equivalent or higher processor recommended )
® 2x or higher CD-ROM drive (4x or higher recommended)

® 20 MB of available hard-disk space

® Microsoft Internet Explorer 5.0 or later
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A Safety Precautions

Please read the safety warnings and cautions provided in this manual to
ensure that you use your printer safely. Do not attempt to use printer in any
way not described in this manual.

Warning  You may cause an electric shock/fire or damage the printer if
you ignore any of these safety precautions.

Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the power cord.
Do not place heavy objects on the power cord.

Never plug the printer into a power socket that is shared with other
equipment (extension lead/cord, 2- or 3- way adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately unplug the
printer at the power supply and call for service.

Periodically, unplug the printer and use a dry cloth to wipe off any dust or dirt
collects on the plug and the power outlet. If the printer is placed at a location

exposed to a lot of dust, smoke, or high humidity, the dust that collects on the
plug absorbs moisture and may cause insulation failure and fire.

Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents such
as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the
printer.

Maintaining the printer

Dho not attempt to disassemble or modify the printer. There are no user serviceable parts inside
the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not
described in this guide.

Working around the
printer

Do not use flammable sprays near the printer.

This could cause afire or electric shock if the spray comes into contact with electrical components
inside the printer.
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Caution You may cause injury or damage the printer if you ignore any of
these safety precautions.

Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or
close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient
temperature range of 5°C to 35°C (41°F to 95°F) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times so you
can easily unplug the power cord if necessary.

When moving the printer, carry the printer at both ends.

Power supply

Never remove the plug by pulling on the cord.

Do not use an extension lead/ cord.

Never use a power supply voltage other than that supplied in the country of purchase.
The correct power supply voltage and frequency is as follows:
Europe: AC 230V + 10M%, 50Hz

USA/Canada: AC 120V, 60Hz
Australia: AC 240V, 50Hz

Working around the
printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents
(alcohol, thinners. etc.) on top of the printer.

Print heads and ink tanks

For safety reasons store print heads and ink tanks out of the reach of small children.
If a child ingests any ink, consult a doctor immediately.

Do not shake print heads or ink tanks.
Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a print head after printing.
The metal parts may be very hot and could cause burns.
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Regulatory Information

Color Printer Model: K10219 (i850)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or
modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A., Inc.
One Canon Plaza
Lake Success, NY 11042

Canadian Radio Interference Regulations

This digital apparatus does not exceed Class B limits for radio noise emissions from a digital apparatus as set out in the
interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radio éléctiques applicables aux appareils numériques de Classe B
prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”, NMB-003 édictée par I'Industrie Canada.
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CANON LIMITED WARRANTY --- (USA Only)

The limited warranty set forth below is given by Canon U.S.A., Inc. (“Canon USA”) with respect to the new or refurbished
Canon-brand product (“Product”) packaged with this limited warranty, when purchased and used in the United States only.

The Product is warranted against defects in materials and workmanship under normal use and service (a) for a period of one
(1) year from the date of original purchase when delivered to you in new condition in its original container or (b) for 90 days
from the date of original purchase for refurbished Products. Defective parts or a defective Product returned to a Canon USA
repair facility or a Canon USA Authorized Service Facility (“ASF”), and proven to be defective upon inspection, will be repaired,
exchanged for new or comparable rebuilt parts, or exchanged for a refurbished Product, as determined by the Canon USA
repair Facility or the ASF. Warranty repair or replacement shall not extend the original warranty period of the Product. A dated
proof of purchase is required at the time of warranty service. A copy of your dated bill of sale will satisfy this requirement.
This warranty does not cover any accessories, or any consumables, such as paper or ink cartridges, as to which there shall be
no warranty or replacement.

This limited warranty shall only apply if the Product is used in conjunction with compatible computers, peripheral equipment
and software. Canon shall have no responsibility for such items except for compatible Canon brand peripheral equipment
covered by a separate warranty (“Separate Warranty”). Repairs of such Canon brand peripheral equipment shall be governed
by the terms of the Separate Warranty. Non-Canon brand equipment and software that may be distributed with the Product are
sold “as is” and without warranty of any kind by Canon USA, including any implied warranty regarding merchantability or
fitness for a particular purpose, and all such warranties are disclaimed. The sole warranty, if any, with respect to such non-
Canon brand items is given by the manufacturer or producer thereof.

This limited warranty covers all defects encountered in normal use of the Product and does not apply in the following cases:

(@  Loss of or damage to the Product due to abuse, neglect, mishandling, improper packaging by you, alteration, accident,
electrical current fluctuations, improper use, failure to follow operating or maintenance instructions, or environmental
conditions, prescribed in Canon USA’s user's manual or other documentation, or services performed by someone other
than a Canon USA repair facility or ASF. Without limiting the foregoing, dropping the Product, scratches, and abrasions
will be presumed to have resulted from misuse, abuse or failure to operate the Product as set forth in the user’s manual
or other documentation for the Product.

(b) Use of parts or supplies (other than those sold by Canon USA) that cause damage to the Product or cause abnormally
frequent service calls or service problems.

(©) If the Product has had it serial number or dating defaced, altered or removed.

ANY SYSTEM SOFTWARE (WHETHER FACTORY LOADED ON THE PRODUCT OR CONTAINED ON THE SOFTWARE DISKETTES OR CD-
ROM'S ENCLOSED WITH, OR ACCOMPANYING, THE PRODUCT), AND ANY UTILITY SOFTWARE, DISTRIBUTED WITH OR FOR THE
PRODUCT, IS SOLD "AS IS" AND WITHOUT WARRANTY BY CANON. THE SOLE WARRANTY WITH RESPECT TO SUCH SOFTWARE IS
CONTAINED IN THE SOFTWARE MANUFACTURER'S LICENSE AGREEMENT DISTRIBUTED THEREWITH, INCLUDING ANY LIMITATIONS
AND DISCLAIMERS THEREON. PLEASE CONTACT CANON IMMEDIATELY IF YOU HAVE NOT RECEIVED A COPY OF THE SOFTWARE
MANUFACTURER'S LICENSE AGREEMENT.

NO IMPLIED WARRANTY, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
APPLIES TO THE PRODUCT AFTER THE APPLICABLE PERIOD OF THE EXPRESS LIMITED WARRANTY STATED ABOVE, AND NO OTHER
EXPRESS WARRANTY OR GUARANTY, EXCEPT AS MENTIONED ABOVE, GIVEN BY ANY PERSON OR ENTITY WITH RESPECT TO THE
PRODUCT SHALL BIND CANON USA, OR ITS ASF. (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.) CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, INCONVENIENCE, EXPENSE FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OR
CORRUPTION OF DATA, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE, OR
INABILITY TO USE THE PRODUCT REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA
OR ITS ASF HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON
USA OR ITS ASF BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT CAUSING THE ALLEGED DAMAGE.
WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR
PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF THE POSSESSION, USE, MISUSE, OR INABILITY TO USE THE
PRODUCT SOLD BY CANON USA NOT CAUSED SOLELY AND DIRECTLY BY THE NEGLIGENCE OF CANON USA, OR ITS ASF. (SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.) THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN
THE ORIGINAL PURCHASER OF THE PRODUCT OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT, AND STATES YOUR
EXCLUSIVE REMEDY.
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Canon offers a full range of customer technical support* options:

For interactive troubleshooting, e-mail technical support, the latest driver downloads and answers to frequently asked
questions (www.canontechsupport.com)

Automated interactive telephone support on most current products 24 hours, 7 days a week (1-800-423-2366)
24-hour, Fax-On-Demand System for Product specifications and technical information (1-800-526-4345)

Free live technical support Monday—Saturday (excluding holidays) for Products still under warranty (1-757-413-2848)
The location of the ASF nearest you (1-800-423-2366, select “automated support options”)

If the problem cannot be corrected by using one of the above technical support options, repair options are available at the
time of your call to the Free live technical support number above or via the website at www.canontechsupport.com

This limited warranty gives you specific legal rights, and you may also have other rights, which vary from state to state.

*

Support program specifics are subject to change without notice.

Canon U.S.A,, Inc.
One Canon Plaza
Lake Success, NY 11042

USA

Canon is a registered trademark of Canon Inc.
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